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INTRODUCTION
Welcome to the learning programme
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Follow along in the guide as the training practitioner takes you through the material. Make notes and sketches that will help you to understand and remember what you have learnt. Take notes and share information with your colleagues. Important and relevant information and skills are transferred by sharing!

This learning programme is divided into sections. Each section is preceded by a description of the required outcomes and assessment criteria as contained in the unit standards specified by the South African Qualifications Authority. These descriptions will define what you have to know and be able to do in order to be awarded the credits attached to this learning programme. These credits are regarded as building blocks towards achieving a National Qualification upon successful assessment and can never be taken away from you!

Programme methodology
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The programme methodology includes facilitator presentations, readings, individual activities, group discussions and skill application exercises.

Know what you want to get out of the programme from the beginning and start applying your new skills immediately.  Participate as much as possible so that the learning will be interactive and stimulating.

The following principles were applied in designing the course:

· Because the course is designed to maximise interactive learning, you are encouraged and required to participate fully during the group exercises

· As a learner you  will be presented with numerous problems and will be required to fully apply your mind to finding solutions to problems before being presented with the course presenter’s solutions to the problems

· Through participation and interaction the learners can learn as much from each other as they do from the course presenter

· Although learners attending the course may have varied degrees of experience in the subject matter, the course is designed to ensure that all delegates complete the course with the same level of understanding

· Because reflection forms an important component of adult learning, some learning resources will be followed by a self-assessment which is designed so that the learner will reflect on the material just completed.

This approach to course construction will ensure that learners first apply their minds to finding solutions to problems before the answers are provided, which will then maximise the learning process which is further strengthened by reflecting on the material covered by means of the self-assessments.

Different role players in delivery process

· Learner

· Facilitator

· Assessor

· Moderator

What Learning Material you should have

This learning material has also been designed to provide the learner with a comprehensive reference guide.

It is important that you take responsibility for your own learning process; this includes taking care of your learner material.  You should at all times have the following material with you:
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Learner Guide
	This learner guide is your valuable possession:
This is your textbook and reference material, which provides you with all the information you will require to meet the exit level outcomes. 

During contact sessions, your facilitator will use this guide and will facilitate the learning process. During contact sessions a variety of activities will assist you to gain knowledge and skills. 

Follow along in the guide as the training practitioner takes you through the material. Make notes and sketches that will help you to understand and remember what you have learnt. Take and share information with your colleagues. Important and relevant information and skills are transferred by sharing!

This learning programme is divided into sections. Each section is preceded by a description of the required outcomes and assessment criteria as contained in the unit standards specified by the South African Qualifications Authority. These descriptions will define what you have to know and be able to do in order to be awarded the credits attached to this learning programme. These credits are regarded as building blocks towards achieving a National Qualification upon successful assessment and can never be taken away from you!
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Formative Assessment Workbook

	The Formative Assessment Workbook supports the Learner Guide and assists you in applying what you have learnt. 
The formative assessment workbook contains classroom activities that you have to complete in the classroom, during contact sessions either in groups or individually.

You are required to complete all activities in the Formative Assessment Workbook. 

The facilitator will assist, lead and coach you through the process.

These activities ensure that you understand the content of the material and that you get an opportunity to test your understanding. 


Different types of activities you can expect

To accommodate your learning preferences, a variety of different types of activities are included in the formative and summative assessments. They will assist you to achieve the outcomes (correct results) and should guide you through the learning process, making learning a positive and pleasant experience.
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The table below provides you with more information related to the types of activities. 

	Types of Activities
	Description
	Purpose

	Knowledge Activities
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	You are required to complete these activities on your own. 

	These activities normally test your understanding and ability to apply the information.

	Skills Application Activities
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	You need to complete these activities in the workplace 

	These activities require you to apply the knowledge  and skills  gained in the workplace
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Natural Occurring Evidence

	You need to collect information and samples of documents from the workplace.
	These activities ensure you get the opportunity to learn from experts in the industry.
Collecting examples demonstrates how to implement knowledge and skills in a practical way


Learner Administration 
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Attendance Register

You are required to sign the Attendance Register every day you attend training sessions facilitated by a facilitator. 

Programme Evaluation Form 

On completion you will be supplied with a “Learning programme Evaluation Form”. You are required to evaluate your experience in attending the programme.

Please complete the form at the end of the programme, as this will assist us in improving our service and programme material.  Your assistance is highly appreciated.

Assessments

The only way to establish whether a learner is competent and has accomplished the specific outcomes is through the assessment process.  Assessment involves collecting and interpreting evidence about the learners’ ability to perform a task.

To qualify and receive credits towards your qualification, a registered Assessor will conduct an evaluation and assessment of your portfolio of evidence and competency.

This programme has been aligned to registered unit standards.  You will be assessed against the outcomes as stipulated in the unit standard by completing assessments and by compiling a portfolio of evidence that provides proof of your ability to apply the learning to your work situation.
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How will Assessments commence?

Formative Assessments 

The assessment process is easy to follow. You will be guided by the Facilitator. Your responsibility is to complete all the activities in the Formative Assessment Workbook and submit it to your facilitator. 

Summative Assessments 

You will be required to complete a series of summative assessments. The Summative Assessment Guide will assist you in identifying the evidence required for final assessment purposes. You will be required to complete these activities on your own time, using real life projects in your workplace or business environment in preparing evidence for your Portfolio of Evidence. Your Facilitator will provide more details in this regard.

To qualify and receive credits towards your qualification, a registered Assessor will conduct an evaluation and assessment of your portfolio of evidence and competency.

Learner Support

The responsibility of learning rests with you, so be proactive and ask questions and seek assistance and help from your facilitator, if required.
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Please remember that this Skills Programme is based on outcomes based education principles which implies the following:

· You are responsible for your own learning – make sure you manage your study, research and workplace time effectively. 

· Learning activities are learner driven – make sure you use the Learner Guide and Formative Assessment Workbook in the manner intended, and are familiar with the workplace requirements.  

· The Facilitator is there to reasonably assist you during contact, practical and workplace time for this programme – make sure that you have his/her contact details.

· You are responsible for the safekeeping of your completed Formative Assessment Workbook and Workplace Guide 

· If you need assistance please contact your facilitator who will gladly assist you.

· If you have any special needs please inform the facilitator 

Learner Expectations 

Please prepare the following information. You will then be asked to introduce yourself to the instructor as well as your fellow learners
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	Your name: 

	

	

	The organisation you represent: 

	

	

	Your position in organisation: 

	

	

	What do you hope to achieve by attending this course / what are your course expectations?

	

	

	

	

	


UNIT STANDARD 116945
Use electronic mail to send and receive messages

NQF Level: 2
Credits: 2
Purpose 

This unit standard is intended for people who need to use electronic mail to send and receive messages either as a user of computers or as basic knowledge for a career in the ICT industry.  

The performance of all elements is to a standard that allows for further learning in this area
Learning assumed to be in place

The credit value of this unit standard is calculated assuming a person has the prior knowledge and skills to: 

· Read, write, communicate and comprehend at least at GET level. 

· Operate a personal computer system. 

· Use generic functions in a Graphical User Interface (GUI)-environment
Unit standard range

This standard is applicable to any messaging application program that allows the assessment of the specific outcomes of the standard

Specific Outcomes and Assessment Criteria

Specific Outcome 1: Understand the concepts and terms of electronic messaging. 

Assessment Criteria
1. The structure of an email address is explained using an example

2. Aspects of Network Etiquette are described.  Aspects: content, subject line, privacy, confidentiality, viruses

3. The benefits of using Email are explained.  May include but is not limited to - speed, cost, time, time zones, portability

4. The limitations of using the Internet are explained.  May include but is not limited to - viruses, security, inappropriate use of Email, attachments

Specific Outcome 2: Create and send an E-mail message. 
Assessment Criteria
1. The electronic mail application is opened 

2. The message is addressed to the required recipients.  Single and multiple recipients; addressee and CC

3. The message header (subject) is consistent with the message purpose, and target audience.

4. The message is checked for spelling mistakes prior to sending

5. Text is manipulated.  Manipulation: copied, moved, deleted. Copy and move to be demonstrated within and Email message and between E-mail messages

6. A file is attached to the email message

7. An attachment is deleted from an E-mail message

8. The message conforms to organisation standards for E-mail

9. A connection is established with an Internet Service Provider

10. The E-mail is sent and received by the intended recipients

11. Application Help functions are used

12. The electronic mail application program is closed

Specific Outcome 3: Receive and respond to e-mails.

1. E-mail messages are received 

2. The senders of the incoming mail are recognised 

3. The contents of incoming E-mails are displayed.  Message, attached files

4. Attached files are saved

5. Incoming mail is highlighted.  Flagged for future follow-up, marked as read / unread

6. Response to incoming mail is initiated.  Reply to sender, reply to all, forward; inclusive and exclusive of the original message.

7. Precautions are observed when receiving mail.  Includes but is not limited to - viruses, discussion lists, spam

Specific Outcome 4: Print an E-mail message
An E-mail is printed to the default printer.  A whole E-mail, specific text within an E-mail message
Specific Outcome 5: Work with multiple E-mail messages
1. A number of E-mail messages are opened.  Minimum 3 E-mail messages

2. Control is switched between the open E-mail messages

3. Text is manipulated between active E-mail messages.  Minimum of 2 active E-mail messages; type of manipulation: move, copy

4. Text is copied to an E-mail message from another source.  Any source other than an E-mail source

5. Text is deleted from an E-mail message

6. An E-mail message is deleted:  Sent to an archive facility and deleted completely

Specific Outcome 6: Adjust settings to customise the view and preferences of the application
1. Toolbar menus are switched off and on 

2. The current view headings are changed

3. Additional columns are added or deleted from the current view

Unit Standard Essential Embedded Knowledge

· Proficient in relevant application packages. 

· Performance of all elements is to be carried out in accordance with organisation standards and procedures, unless otherwise stated. Organisation standards and procedures may cover: quality assurance, documentation, security, communication, health and safety, and personal behaviour. 

· Performance of all elements complies with the laws of South Africa, especially with regard to copyright, privacy, health and safety, and consumer rights. 

· All activities must comply with any policies, procedures and requirements of the organisations involved, the ethical codes of relevant professional bodies and any relevant legislative and/ or regulatory requirements. 

· Performance of all elements is to be completed within the normal range of time and cost that would be expected in a professional environment (e.g. In a commercial or government organisation).
Critical Cross-field Outcomes (CCFO)

· Unit Standard CCFO Identifying Identify and solve problems in which responses display that decisions using critical and creative thinking have been made
· Unit Standard CCFO Organising: Organise and manage oneself and one’s activities responsibly and effectively

· Unit Standard CCFO Collecting: Collect, analyse, organise, and critically evaluate information
· Unit standard CCFO Communicating: Communicate effectively using visual, mathematical and/or language skills in the modes of oral and/or written persuasion when engaging with the subject

· Unit Standard CCFO Science: Use science and technology effectively and critically, showing responsibility towards the environment and health of others
CONCEPTS AND TERMS OF ELECTRONIC MESSAGING
Outcome 

Understand the concepts and terms of electronic messaging 

Assessment criteria
1. Explain, with an example, the structure of an email address 

2. Describe aspects of Network Etiquette:  content, subject line, privacy, confidentiality, viruses

3. Explain the benefits of using Email: speed, cost, time, time zones, portability

4. Explain the limitations of using the Internet: viruses, security, inappropriate use of Email, attachments

What Do You Need For E-Mail Messages?

· A computer

· Connected to the Internet via an Internet Service Provider (ISP)
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E-mail software

· An e-mail address

· A telephone line

· A modem

How E-Mail Works

Sending and receiving e-mail is similar to sending and receiving mail via the Post Office. 

[image: image57.png]welage | et Optlons  Fomatled  Redew

N T Y S e

o , R —
e ) By WA BET EE e o s e e

cmnmoa-n - A X

=
&

" Book Name: it Remr - 8 lowimpotance
clpsoud 12 BaicTent ol tames inciude « z00m
[ fon+ | youmanegyourispcons
oo To. | [smecemen
Send L !

<
Subject  [Anicephato

Atacnes

Dear (someone's nome),
1would ike o enter this photo for the Gompetiition| +———

Regards,

(Your name)

D See more bout: someone@isp.com.




When You Want To Send Mail, You Need The Following:

· A letter that you have written (or typed) 
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An envelope on which you have written the person’s address

· A stamp must be fixed to the envelope and then

· You take it to the Post Office to mail it in the red mailbox. 

Similarly, If You Want To Send An E-Mail, You Need:

· To be connected to the Internet, with the required e-mail software, in this case Outlook

· the e-mail address of the person you want to send e-mail to - the recipient

· A mailbox where you can mail outgoing messages: the Outbox folder in Outlook. Once you have created an e-mail, it is stored in the Outbox until you go online again, then it is sent to the recipient. 
The advantage of e-mail is that, once the message has been sent, you still have a record of it in the Sent Items folder of Outlook
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If You Want To Receive Mail Via The Post Office, You Need:

· A Post box

· A postal address

· To collect mail regularly
· To Receive E-Mails You Need:

· To be connected to the Internet, with the required e-mail software, in this case Outlook

· An e-mail address

· A postal box in which to receive e-mails: the Inbox folder in Outlook is where all your incoming mail will be stored.
What Does An e-Mail Address Look Like?

narina@photography.co.za

An e-mail address consists of four parts…

· Your name - narina

· The @ sign that separates your name from the name of your ISP
· The name of your ISP - photography

· The domain - .co.za. The domain of course tells us it is a company in South Africa
Network Etiquette

Content

If you are sending emails from your work email address you should be careful of what you include in the e-mail.  It is easy to track the origin of an e-mail, so if you put vulgar, explicit or discriminatory content in an email, you could be caught and prosecuted.  Your system administrator can penalise you by taking away your e-mail and Internet privileges.  
Furthermore, if you send an e-mail from work, you could embarrass your employers, that is why your system administrator always monitors e-mails.

Work related content that you send in an email should be typed in the same format as a normal business letter.  It creates a professional appearance.
Here, we'll discuss some business writing rules and tips for practicing e-mail etiquette. 

People are busy, so: 

· Use the subject line. You might be tempted to bypass this part of the e-mail, but just remember: everyone is in a hurry, including the recipient of your e-mail. That person will appreciate the clue the subject line provides as to the message content. It helps them prioritize and organize. 

· Be brief and concise. No matter how clever and entertaining a writer you might be, your message recipients will appreciate brevity and clarity. Save the puns and witty turns of phrase for after birthday cards and toasts. State the message quickly followed by clear requests or instructions for any action needed by the recipient. 

· Keep it personal. Routinely copying others on e-mails clogs mailboxes and can lead to the main recipient wondering why you're doing so. Unless you have a specific reason for copying someone, keep the conversation between sender and recipient. 

· Reply quickly. Don't let e-mails sit around in your queue unanswered. Get back to the sender, even if it's to say you need more time to respond. 

People are sensitive, so:

· Don't over-punctuate. Adding multiple punctuation marks, such as ???? or !!!! after a sentence makes it seem as though you are shouting or frustrated with the recipient. Use normal punctuation rules. 

· Don't use all capitals. Using all caps MAKES IT SEEM LIKE YOU'RE SHOUTING. Shouting is rude. Use normal capitalization rules. If you need to emphasize something, write "I'd like to emphasize…" 

· Read it, out loud, before you send it. While you may think you're writing exactly what you mean, it pays to read some e-mails out loud to yourself, putting yourself in the recipient's shoes, before hitting that "send" button. Once it's in writing, it's hard to take back. Also, never forget that the recipient has both a printer and "forward" button. Never write something you wouldn't want to have circulated throughout the company or even beyond. 

· Don't write when you're angry. Perhaps one of the most common etiquette rules to break is firing off an e-mail to someone when you're angry, either at them or a situation. See "Read it out loud" above. You can't take it back once you "flame" someone, and it can come back to haunt you. 

Not everyone is as hip as you are, so:

· Keep the symbols to a minimum. Using "smiles" is a trendy way to communicate mood and meaning. But do you know the difference between a sarcastic smile and a mischievous one? And even if you're sure you do, can you be sure your recipient does? It's easy to see the potential to unintentionally offend someone using these symbols. Avoid using them. 

· Minimize abbreviated phrases. Using abbreviations such as IMHO (in my humble opinion). FWIW (for what it's worth) and ROTFL (rolling on the floor laughing) can frustrate and confuse the recipient. 

E-mail is like as a business letter. Ignoring basic rules can show disrespect for the recipient. Don't let informality spoil the recipient's opinion of you. 

Privacy

There are a couple of things that influences privacy on a network.  Most networks are not very private if it’s in an open office.  There are some office environments where passwords are not allowed. If you are allowed a password on your computer, your mails should be safe and private, although the company can give the network administrator permission to access your emails if they suspect you are doing or sending something you shouldn’t be. 
Confidentiality

Some emails contain a confidentiality disclaimer.  If you find a mail like this, it is best to keep the contents of the mail you received confidential.  The disclaimer can be found at the bottom of the email.  You will find that disclaimers are most commonly found on emails from corporate companies.

Of course, just as you would like your e-mails to be confidential, so do your colleagues want their e-mails to be confidential.  Respect other people’s privacy and they might just respect yours.
Benefits Of E-Mail

Email has become one of the most popular ways of communication, and for good reasons as well.  Let’s see why. 
Cost

Sending an email is a lot more cost effective than to actually drive to the destination you would like your mail to reach.  It is hard to determine exactly what it would cost to send an email, since It would depend on the size of the mail, how long it takes to send and the type of line you are using. 
However, since you can send mail to a lot of recipients, it is cheaper than sending snail mail via the Post Office.  One letter can cost R1,50, while you can send a lot of e-mails for the cost of one local phone call. 
There are two types of Internet lines you can make use of:

ISDN and ASDL 

· An ISDN line is a dialup line that uses a modem to connect to the Internet.  By saying dialup it means every time you go on the Internet the modem dials an assigned number given to you by your ISP (Internet Service Provider).  When you dialup to the Internet via an ISDN line, Telkom starts charging from the minute you start dialling until you are done and you disconnect.  This is why the cost will vary according to the size of the email.  A larger mail will take a longer time to send and a smaller mail will take a shorter time to send.

· An ASDL line is a permanent Internet connection.  It also tends to be faster than an ISDN line in the sense that it carries more information to and from your computer in a shorter time frame. An ASDL line does not dial out like an ISDN line.  It is permanently connected to the Internet and you pay a set price per month, unlike an ISDN line where you pay for the amount of time you spent on the Internet.  

Time

As you can imagine, sending an email is a lot faster than actually delivering the message in person or sending it via snail mail. It saves an immense amount of time.  The Postal service would take a minimum of three days while an mail reaches the destination within seconds.
Time zones

Mail is a wonderful way of communication when it comes to time zones.  If you are in South Africa and I am in America in New York, I would be seven hours behind the time you are.  If it is 12:00pm in South Africa it would be 5:00am in New York.  If you would like to send me an email at 12:00 you wont be disturbing me while I’m probably still sleeping, plus the mail reaches me almost immediately.  By the time I get out of bed at 6:30am the mail is ready and waiting for me to be read.  This way we overcome the problem of time zones. 

Portability

Emails are very portable.  If you have received it on your computer and you need it on another computer, you can just transfer it with a memory stick or mail it to another computer where you need it.  This is very convenient.  It is also convenient in the sense that you can save them and that way they don’t get lost like papers normally do.

You can also download e-mails from any Internet Café, so you don’t have to be at your own computer to download and read your e-mails.
Limitations Of Using The Internet

Viruses

Viruses on the Internet is unfortunately a big problem.  Certain applications that you will receive via email contain viruses.  If you open the attachment the virus is loaded onto your computer without you even knowing about it.  It is never wise to open emails or attachments from people that you don’t know.  The virus then activates itself on your computer and disrupts some or all operations on the computer.

Security

Security is also an issue on the Internet.  Every legitimate website is supposed to have a security certificate.  You can see at the bottom of the site if it is a certified site.  Unfortunately a lot of websites are forged, so, for example when you want to buy something from the site and enter your banking details the person who forged the site, normally referred to as a hacker has your bank details. 
When this happens hackers have a nasty habit of emptying your account.  As you can see it is very dangerous to enter your details on just any website.  It is very important to find out if the website has a reliable source.  You can do this by checking for the above-mentioned certification icon.  

Inappropriate use of email

People tend to abuse it when they get an email address at work.  The reason is that it is free for the employee to send an email to friends and family instead of phoning them on their own account.  At times it happens that the friend also has permanent Internet connection and so they “chat” all day long.  This wastes of the employers time and money, since the employee is not productive during the time that is spent on the Internet.  
Formative Assessment

Explain the structure of the following e-mail address:  narina@photography.co.za

· narina:

· @:

· Photography:

· .co.za:

· List three aspects of Network etiquette

· List three benefits of e-mail

· List three limitations of the Internet

· What do you need to send e-mails?

MS OUTLOOK
Outcome 
Create and send an E-mail message

Assessment criteria
· Open the electronic mail application 

· Close the electronic mail application program
Start Outlook
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Once Outlook has been installed on your computer you can start the application clicking the Outlook icon.

OR

On the Taskbar, click the Start button then select the Programs menu item.

· The Programs submenu is displayed.

· Click the Microsoft Office program item
· Click the Microsoft Outlook program item
The Outlook Application Window

The layout of the Outlook application window is very similar to other Office applications. It has a Title and Menu bar, several toolbars and a Status bar.

The main part of the window is divided into several frames (or panes). The pane(s) on the left are used to navigate the window and is called the Navigation Pane

The rest of the screen (the Information Viewer) shows the component selected.

Your Outlook screen may look different to the one shown on the next page with more or fewer panels and toolbars. 

The Title Bar


[image: image2]
The Title bar shows you which application (software program)you are running and it also shows you the name of the MS Outlook component you have open (Inbox). 
On the left-hand side of the Title bar is the Program icon. If you click this a menu of commands to control the Outlook window is displayed. 
You can also use the Minimise, Maximise /Restore and Close buttons on the right-hand side of the Title bar to control the window.
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The Ribbons

[image: image4]
First introduced in Microsoft Office Outlook 2007, the ribbon is part of the Microsoft Office Fluent user interface. It is designed to help you quickly find the commands that you need to complete a task. Commands are organised in logical groups that are collected together under tabs. In Outlook 2010, the ribbon has replaced the former menus in the main Outlook window. In addition, the ribbon can be customized to include custom tabs that you can personalize to better match your work style.

The ribbons include: File, Home, Send/Receive, Folder and View. The groups under each ribbon contain the commands you will use to access the features of Outlook, in other words to give Outlook the commands to do what you want it to do: send the completed e-mail, print the e-mail, etc.

Toolbars

Toolbars used to contain icon buttons that are shortcuts to selecting the command from a menu. These are now integrated and included under the ribbons.  
The example below is the Home ribbon.  


[image: image5]
On the Home ribbon you will find different groups containing some of the buttons that used to be available on the toolbars in previous versions of Outlook.  Some of these groups include: New, Delete, Respond, Quick Steps, Move, Tags, Find and Send/receive.

To move between ribbons, simply click on the ribbon name and the ribbon will open with other groups and options.
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ScreenTip

When you point to a button on in a group , a ScreenTip will appear.  The ScreenTip describes what the button does.
The Status Bar

The Status bar displays relevant information including the number of items and if they have been read as well as the progress when send/receiving mails.
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Scroll Bars

Sometimes the information on the screen is larger than area where it is displayed, such as a message.  When this happens you cannot see the entire message.

Scroll bars help you to move around quickly so that you can read the message.

You can scroll around by clicking the scroll arrows at the top or bottom end of the scroll bar or by dragging the scroll button in the scroll bar.

Menus/Ribbons
The commands contained in the Ribbons are grouped according to function.  For example, in the Send/Receive ribbon, you will find groups related to sending and receiving emails.
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When you click on a Ribbon, such as Home, you activate the ribbon so it is displayed.  In this ribbon you will find groups of commands that pertain to the menu heading.

You can use the mouse or the keyboard to select a command from a ribbon or groups.

When a command appears faded out, we call it "greyed out".  This means that the function cannot be used right now, you first have to do something else that will activate this function. 

When commands have an arrow beside them, it means that there is a submenu which contains a group of commands that relate to the main command.  For example, if you click on New Items, the submenu will contain commands that relate to opening new items in Outlook.

Point to or click on the submenu to select the next command or next submenu.
Select A Ribbon Using The Mouse

· Click on the ribbon you want to select.

· Browse through the groups for the command you are looking for
· Click once on the command to select it.

The Inbox Information Viewer

This part of the Outlook screen will change according to the Outlook component you are using.  For example, the windows of the Inbox and Task components look different.

You can make the left or right window panes larger or smaller, by clicking-and-dragging on the split bar.


[image: image7]
The Navigation Pane and Folder List
The Navigation Pane shows the name of the folder displayed in the Information Viewer. 

By clicking the arrow on the Navigation Pane, you can view a list of all the components and folders available in Outlook. This list resembles the Explorer pane in Windows. You can use it to open different components in the Information Viewer.  If the Navigation Pane is not open, it will appear minimised on the left of the screen. 

[image: image8]
Navigate in the Folder List

· Click the arrow on the Navigation Pane to reveal the Folder List
· Click the arrow once more to minimise it again.

· Click an item in the folder list to open It


[image: image9]
Group Buttons
Group buttons can be found at the bottom left of the screen.  These buttons are short cuts put here for ease of access to the different groups of ____ available in Outlook.
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Exit Outlook

If you minimise Outlook, it will remain open on the Taskbar while you are working in other software applications.  When you want to work in Outlook, click on the Outlook button on the Taskbar and the Outlook window will be displayed.

When you want to shut down the PC, you have to exit Outlook first.

There is more than one way to quit Outlook.  When you become a more experienced user, you will choose the method that works best for you.

Close Outlook

· Click the File menu, then click Exit  

· OR
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Click the Close button at the top right-hand corner of the Outlook window. [image: image11.png]


 OR
· Exit Outlook by double-clicking on the Program Icon in the top left hand corner of the Outlook window. 

Formative Assessment

· Open Outlook

· Close Outlook

CREATE AND SEND AN E-MAIL MESSAGE
Outcome
Create and send an E-mail message

Assessment criteria
· Address he message to the required recipients:  Single and multiple recipients; addressee and CC

· Ensure that the message header (subject) is consistent with the message purpose, and target audience.

· Attach a file to the email message

· Delete an attachment from an E-mail message

· Ensure that the message conforms to organisation standards for E-mail

· Send the E-mail

· Ensure that the E-mail is received by the intended recipients
Create A New E-Mail Message

In order to send an email, you have to create the message in Outlook.  Once you have created a message, you must ensure that 

· you have addressed the message to someone, 

· you have given the message a subject
· you have done a spell check
· included all the necessary attachments
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before you actually send the message.
· On the Home ribbon or from the New group, select the New Email button 

[image: image12]
The mail item also appears on the Taskbar, so that you can switch between it and other Windows programs.  It shows on the Taskbar as Untitled Message.
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Enter Data Into The Mail Window

To…

Enter the e-mail address of the recipient in the To… box.  You can enter the names of more than one recipient in the To… box, as long as you separate the names with a semicolon(;), for example: 
narina@photography.co.za;albert@hotmail.co.za;yourname@timdutoit.co.za
Cc…

To enter an e-mail address in the Cc… box, follow the same procedure as above. Cc stands for Carbon Copy.  CC means that the e-mail is sent to that recipient for information only, the recipient does not have to respond or reply to the message.
Bcc…
Bcc stands for Blind Carbon Copy. When you enter a recipient’s address in the Bcc… box,  the recipients in the To… and Cc… boxes will not see the names of the recipients in the Bcc… box - that is why it’s called Blind Carbon Copy.  You will use the Bcc… box when you do not want the recipients in the To… and Cc… boxes to see that you are sending the message to a specific recipient.
If the Bcc… box is not displayed, click the down arrow to the right of the Options... button and select Bcc.

You can use either the Cc… or Bcc… boxes without using the To…box, as long as there is at least one recipient in one of the three boxes the e-mail can be sent.

Enter a Subject Heading

Once you start sending and receiving e-mails, you will find that a lot of correspondence and communication is conducted this way.  It is possible that you will send and receive up to 300 e-mails daily.  You will therefore appreciate it when people who send you e-mails give an appropriate subject heading, as the e-mail will be listed in your Inbox under the subject heading.

Giving the mail a subject heading such as: Thabo’s mail will be silly.  When you write or type a document at work for a client or a superior, you always include a subject heading that gives details about the letter.  The same principle will apply to an e-mail subject heading.

If the mail is about a weekly or monthly meeting, for example, include the full details of the meeting and the purpose of the e-mail, which could be the agenda or minutes of the meeting: 

Agenda for weekly meeting to be held on 25 Jan 06

OR

Minutes of meeting held 15 Jan 06
If you only state minutes of meeting and the meeting is held every week, you will end up with about 50 e-mails with the same subject, which will make your life and the lives of the recipients very difficult when you want to find the minutes of a particular meeting.

Think carefully about the subject heading and make sure that it makes sense, conforms to the protocol as prescribed by your organisation and, above all, ensure that it will be easy to find this particular e-mail again.

· eq \X(Tab) to or click in the Subject: box

· Type a subject heading for the message

Body of the message

eq \X(Tab) to or click in the main box, where you will enter the message.  
Remember that an e-mail is usually an electronic form of a letter.  Follow the same format as If you are typing a letter.  If it is to a friend, it can be informal, if it is to a manager, it has to be more formal.

Insert A File Attachment

At times, you will want to add an attachment to your e-mail

· When you have typed a report, an agenda or minutes of a meeting in Word and you want to attach it to the mail

· Or you want to include a picture

· Or attach an e-mail to your mail
· Or an Excel spreadsheet containing statistics, etc.
It is possible to include more than one data file with your email message. Any type of file can be attached to a message, including documents, spreadsheets, graphics and so on.  Be careful of attaching too many data files to your e-mail, as it can make the mail bulky and slow to send and deliver to the recipients.  Just as smaller packages are easier to fit into your postal box at the Post Office, smaller e-mails are quicker and easier to send.

You will also have to take the following into consideration when using file attachments:

· Most, but not all, email systems can receive file attachments.

· The recipient can only open and edit the attachment if they have the correct software - they cannot open the attachment in their email editor.

· Large file attachments can be very slow to send and receive. Just like in your mailbox at the Post Office where it is easier to receive more than one smaller package than one large package, your mailbox (and the recipient’s mailbox) can handle smaller attachments with more ease. This means that at times you will send more than one e-mail to the same person, each one with one attachment, rather than one e-mail with many attachments.

· Some email systems will reject messages if they exceed a certain size (often 1 MB).

· File attachments can contain computer viruses
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Attach A File To A Message

· On the Message ribbon, click the Attach File button in the Include group, OR 
on the Insert ribbon, click the Attach file button in the Include group.  
· The Insert dialogue box will be displayed.  Ensure that the Files of type text box is set to All Files.  This way you will see all the files that are available.

[image: image14]
· Browse to select the file you want to insert and then click the Insert button in the dialogue box. You will usually find the file that you want to attach in the Documents folder.
· You will see the file attachment in the Attach... box underneath the Subject: box.

· If you attached the incorrect file and want to delete the attachment, click the attachment icon in the Attach... box and press eq \X(Delete) on your keyboard.

· To attach more files, follow the same procedure for each file.
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Insert An Existing Message Or Other Outlook Item
Outlook allows you to insert an existing e-mail or any other Outlook item, such as a task or a contact card to your e-mails. 
· to select the item, click the down arrow on the Attach Item button on the Home ribbon, browse and click on the item you want to insert.

· Click OK.  The item will now be inserted in the email as an attachment. 

[image: image16]
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Insert An OLE Object Into A Message
An OLE object is a "live" file, in that the information it contains is updated as the original data is changed.

· Open a New Message

· From the Insert ribbon, select Object in the Text group...

· The Object dialogue box is displayed.

· From the Object Type: list box, click on the application in which you want to create the object for example an Excel Worksheet.
· Create the object as required

· Click OK for the object to appear in your email.
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Adding A Signature

A signature is text that is automatically added to messages you send. For example, you can create a signature that includes your name, job title, and telephone and fax number. It can include any text you wish. Because an e-mail carries legal status and is recognised in law as a document in much the same way as a letter, many companies are now including a disclaimer at the end of e-mail messages. 

Disclaimers can be included in signature text.

Create A Signature

· From the Outlook window, select the File menu, then Options, and click the Mail button in the left hand tab.

· Click the Signature button, and then click New

· Next, type a name for your signature and click OK.

· Here you can create your signature in the blank box or you can copy and paste a signature in the box such as the image in the example below.
· Select the email address for which you want to use the signature and click OK.  The signature will now appear on all the emails you want to send from the email address you specified.
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Tip Font and paragraph options are not available if you use plain text as your message format.

Send A Message

· To send your message once you are done, simply click on the Send button next to the address and subject fields on the message. 

[image: image20]
· If you have a dial up connection and you have to connect to the Internet before you can send messages, your message will be posted to the Outbox folder for sending when you go on line.

· If you are on line all the time, the message will be sent directly and will appear in the Sent Items Folder.

· To ensure that the e-mail has been sent, click on the Sent Items folder.  Check that your message appears in the folder.  If the message is not in this folder, check the Outbox folder.  If you message still appears in the Outbox folder, it has not been sent.  Open the message and click on the Send button.  Once again, check that your message has been sent.

Formative Assessment

· Open Outlook

· Send an e-mail to the facilitator, telling him how you think you will benefit from the course.

· Cc the mail to your fellow students

· Remember to add a subject heading

· Attach any file to the mail

· Send the mail
EDIT AN E-MAIL MESSAGE
Outcome 

Create and send an E-mail message

Assessment criteria
· Check the message for spelling mistakes prior to sending

· Manipulate text: copied, moved, deleted. Copy and move to be demonstrated within and Email message and between E-mail messages

· Establish a connection with an Internet Service Provider

Check Spelling

Check Spelling Of The Open E-Mail 

· Open the item you want to check, and then click in the body of the item. 

· On the Review ribbon menu, click Spelling & Grammar. 
· Unless you have selected text, the spelling check will begin at the insertion point.  When an incorrect word is found, the Spelling dialogue box is displayed.


[image: image21]
Select one or more of the following:

Select To Ignore or Ignore All Skip only the current instance of the word or all instances of the word

Change or Change All Correct a word or all instances of the same word with the spelling in the Suggestions: box Add to Add a new spelling to the custom dictionary

When the spell check is complete, click OK

[image: image22]
Check Spelling Automatically When Sending The E-Mail

· From the main Microsoft Outlook window,  click on the File ribbon, open the Options menu and click Mail.
· Select the Always check spelling before sending check box.
· Any words you add during a spelling check are placed in the custom dictionary, called Custom.dic


[image: image23]
Manipulate Text

What Is The Difference Between Copy And Move?

· When you copy a part of your mail, or even the whole mail, it is similar to photo copying a document: you have the original and the photocopy.  With Outlook it works like this - the original remains in its place in the document and you have a copy that you can paste in a new mail.

· When you move a part of your mail, or the entire mail, it is like cutting out the part that you want to move. This means that, when you move mail text or a part of a mail’ text, the portion that you are moving will no longer be in its original position.  You will have the original portion that you are going to paste into a new mail.
Selecting Text

Before you can copy or move text from one e-mail to another, you have to select the text you want to copy or move. You do this by clicking and dragging the mouse over it. Move the mouse pointer to the beginning of the text you want to select.  Click the mouse button, hold it in and drag to the end of the text you want to select. The text will then look different to the rest of the document, to show that it has been selected.
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How Do You Copy?

· First, select the text you want to copy

· To copy, you have two choices: you can copy from the Message ribbon, look in the Clipboard group for the Copy button and click on it to copy the text.  The other option is to highlight the text and holt Ctrl + C on the keyboard.  This is the keyboard shortcut for copying text.  
· Move the mouse indicator to the new place (location) where you want to place the text and click.

· Then select Paste. The selected text will appear in the new location.

[image: image24]
Move Text From One Location To Another Using The Edit Menu

· Select the text to move. 

· Select the Message ribbon and click on Cut in the Clipboard group. The text will no longer appear in the old location.

· Move the mouse indicator to the new place (location) where you want to place the text and click.

· Then click on Paste. The selected text will appear in the new location.
Delete Text

There are several ways of deleting text: 
· Backspace will remove characters to the left of the insertion point 
[image: image76.png]



· Delete will remove characters to the right of the insertion point 
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· To delete the extra spacing between two paragraphs, press Backspace twice. Remember to put an extra space with the spacebar between the two sentences. 

· You can also select text so that it is highlighted and then press delete. The entire highlighted text will be deleted. 

· Select and replace text: when text is selected (highlighted) you can replace this text by typing new text.  Always remember to check your spacing when you have deleted or inserted text.
Connect To The Internet

· If you are working with a dial-up connection, a dialogue box will appear as soon as you click on Send.  Sometimes this message will also appear as soon as you open Outlook

· If you wish to connect to the Internet immediately, click Dail.  (Click Cancel if you have more messages that you wish to compose or if you want to connect at a later stage.)

[image: image78.wmf]
· If you click Dail, the Internet Connection dialogue box will appear.

· Complete the dialogue box as appropriate and Outlook will connect to the Internet and send all the messages in your Outbox, and at the same time download incoming mail messages into our Inbox.

· Ensure that you disconnect as soon as your messages have been sent and downloaded.

· If you have access to an ADSL line, which means that you are connected to the Internet permanently, the message will be sent immediately without you having to connect as above.  Also, you will receive e-mails as soon as they are delivered to your Inbox

READING MAIL MESSAGES
Outcome 

 Receive and respond to e-mails

Assessment criteria
· Receive E-mail messages

· Recognise the senders of the incoming mail 

· Display the contents of incoming E-mails:  Message, attached files

· Save attached files 

· Highlight incoming mail:  Flagged for future follow-up, marked as read / unread

· Respond to incoming mail:  Reply to sender, reply to all, forward; inclusive and exclusive of the original message.

· Precautions are observed when receiving mail.  Includes but is not limited to - viruses, discussion lists, spam

· Delete E-mails

Open, Reply To And Forward A Mail Message

As soon as you receive an e-mail message, it will be downloaded into your Inbox from the Mail Server.  To access your incoming mail, click on Inbox, either in the Navigation Panel or the Information Viewer.

The list of your e-mails will be displayed in the Information Viewer.

Open A Message

Double-click on the message to open it.  The message will open in a separate message window.  Now you can read the entire message. 
Reply To A Message

· You can choose to send a reply only to the sender of the message.  If this is what you want to do, click the Reply button: 
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· If you want your reply to go to the sender as well as all the recipients in the Cc… and Bcc.. boxes, click the Reply to All button: 
· If you want to forward the message to a third party who has not yet received the message, click the Forward button: 
· All these options will open the mail that you received in a new mail message window.  Now you can add your comments to the top or the bottom of the mail and send the mail to the recipients.

· If you used the Reply or Reply to All buttons, the e-mail addresses of the recipients will appear in the To…, Cc… and Bcc… boxes.  You don’t have to add any addresses

· If you used the Forward button, you will have to add the e-mail address of the new recipient in the To…, Cc…, or Bcc… box, whatever your choice may be.
Replying with the original message insertion

By default, when you reply to a message, the original message is included in the reply.

You can change the default options to exclude the original message or to include it in a different format. If you do not want to include the original message in a specific reply, you can simply delete the text.

Remove the original message from one reply

· Click-and-drag to select the text of the original message

· Press eq \X(Delete)
Change the default options

· From the main Outlook window, from the File ribbon, select Options...
· On the Options menu, click on Mail.
· The Mail Options dialogue box is displayed.

· From the Replies and Forwards options list, click on the drop down arrow and select an option to apply to all future emails

· The effect of the option is previewed in the graphic. Click OK to exit both dialogue boxes
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Open And Save An Attached File

When someone sends you an attachment to the e-mail, it will appear in the Attachments field, under the Subject or in the body of the message.  

Warning
Be careful of opening file attachments as they can contain viruses that can damage your computer. The virus will be activated as soon as you open the attachment. Install an up-to-date anti-virus program to scan for viruses on your computer. Your ISP or system administrator will also take precautions against viruses. As a general rule, don’t open file attachments that you were not expecting to receive. It is also wise to install an up-to-date virus scanner capable of checking incoming email.

Open An Attached File

· Open the message

· The formatting of file attachments can vary.  If the format is HTML or plain text, the attachment icon appears in the Attach... box underneath the Subject line of the message.

· If the attachment is in any other format, the icon that represents the attachment will appear in the body of the message and will not appear in the Attach… box. .

· It does not matter if the attachment appears in the body of the message or in the Attach… box, to open the attachment you have to double-click on the attached file's icon 
· A warning about attachments that may contain viruses or malicious scripts will be displayed in the bottom area of the email. It can be dangerous.  Be especially wary of mails that promise you prizes or other fantastic rewards.  Contact your ISP or system administrator immediately.  If you have doubts about the sender or the attachment, Close the email and Delete it.
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· Once you have opened the attachment and you want to save it, follow the steps required by the program in which the attachment opened, for example if it is a Word document, go to the File, Save As menu to save the document.
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What Is HTML

It stands for Hypertext Markup language and is basically the programming language that allows computers to talk to each other via the Internet
Highlight Incoming Mail

At times you will send and receive e-mails which have to be replied to at a future date.  A typical example is minutes of a meeting that was sent to everyone who attended.  They then have to read the minutes, approve them and reply at a certain date.  Or a colleague or manager has requested you to obtain information that he/she will need in time for a meeting in, say two weeks’ time.  Whatever the situation, you can flag a message for follow-up.

Flag A Message

· [image: image80.wmf]Select the message you want to flag.

· Open the Home ribbon, and find the Follow up button in the Tags group.

· Click on the drop down arrow and select the options you want.  The arrow next to the message will change now. 
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Remove a message flag

· To remove a flag from a message, simply click on the flag next to the message and it will no longer be there.  The box where the flag was will now turn to a green tick to show the flag task has now been completed.

· Alternatively go to the Tags group, click on the drop down arrow next to Follow Up and click on Clear Flag.

When you have opened and read a message, the header of the message will no longer display in bold text in your Information Viewer.  It follows, then, that the headers of unread messages will display in bold text in the Information Viewer.  Furthermore, the number of unread messages will show in bold text next to the Inbox folder in the Navigation Pane.

You can, of course mark messages as Read or Unread, if you so choose.

Select the messages you want to mark as read or unread

· Go to the Home ribbon and select Mark as Read or Mark as Unread.  Unread message will show in the Information viewer with a closed envelope icon next to them, while messages that have been read will show with an open envelope icon next to them.
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Delete E-Mails
Permanently Delete E-Mails

· To delete an e-mail, select the message you want to delete and click on the Delete button in the Delete group on the Home ribbon.  The mail will be moved to the Deleted Items folder.

· Right click the Deleted Items folder and then click Empty Folder.
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Archiving Folders
Archiving moves items in your Outlook folders to a specially compressed .PST folder on your PC.

Archiving means that Outlook takes up less space on disk and runs more efficiently. By default, Outlook will periodically prompt you to archive certain folders. You can change the way this process (AutoArchive) is set up and also manually archive a folder.
Any Outlook item that has exceeded its aging period is included in the next AutoArchive, unless the item has been specifically marked to be excluded. The default aging period for each Outlook folder is as follows:
	Folder
	Aging period

	Inbox and Drafts
	6 months

	Sent Items and Deleted Items
	2 months

	Outbox
	3 months

	Calendar
	6 months

	Tasks
	6 months

	Notes
	6 months

	Journal
	6 months


Note:  Folders that you create that contain the same type of items as the Inbox, Calendar, Tasks, Notes, or Journal have the same default, six-month aging period. For example, a mail folder that you create for status reports received from a co-worker or a contact folder you create for personal contacts.

To manually archive a folder
To manually archive Outlook items, do the following:

1. Click the File tab

2. Click Cleanup Tools.

3. Click Archive.
4. Click the Archive this folder and all subfolders option, and then click the folder that you want to archive. Any subfolder of the folder you select is included in this manual archive.
5. Under Archive items older than, enter a date.
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6. If you do not want to use the default file or location, under Archive file, click Browse to specify a new file or location. Browse to find the file that you want, or enter the file name, then click OK. The destination file location appears in the Archive file box.

7. Select the Include items with “Do not AutoArchive” checked check box to include any items that might be individually marked to be excluded from automatic archiving. This option does not remove that exclusion from these items, but instead ignores the Do not AutoArchive check box for this archive only. 

Setting Up AutoArchive
AutoArchive usually runs by default when you install Outlook. You can configure AutoArchive settings and alter archive properties for particular folders.

See the following descriptions for the settings and options that you can apply when customising AutoArchive.
Open the File ribbon and click on Options.  Next click on Advanced and then AutoArchive settings.  
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Run AutoArchive every xx days:    Choose how often AutoArchive runs. Archiving many items at the same time might slow your computer's performance. Therefore, it is better to use AutoArchive more frequently to reduce the number of items processed.

To turn off the AutoArchive feature, clear the Run AutoArchive every xx days check box.

Prompt before AutoArchive runs:    Choose whether you want a reminder message to appear before AutoArchive processes your Outlook items. When prompts appear, you can click No on the reminder message to cancel that AutoArchive session.

Delete expired items (e-mail folders only):    This option is off by default. Select this check box to delete messages after their aging period has passed.

Archive or delete old items:    Choose this option if you want to set or change the settings that follow. If this check box is cleared, AutoArchive runs using default settings.

Show archive folder in folder list:     Select this check box to have the Archive folder listed with your other working folders in the Navigation Pane. If you do not use this option, you can still open your archive folder — click the File tab, then on the Open tab, click Open Outlook Data File.

Clean out items older than:    Specify the age at which you want items to be archived, in days, weeks, or months. You can configure a period of one day up to a maximum of 60 months. 

Move old items to:    Select this check box to archive old items instead of automatically delete them. The default folder appears in the box. To use a different folder, enter the folder location in the box or click Browse. Selecting this option clears selection of the Permanently delete items option.

Permanently delete items:     This option deletes any expired items. They are not moved and no archive copy is kept. Selecting this option clears selection of the Move old items to option.

Apply these settings to all folders now:    This option applies the AutoArchive settings, including your changes, to all folders. To specify unique settings for one or more folders, do not choose this option. Instead, right-click the folder, click Properties and then go to the AutoArchive tab to change settings for each folder that you want to change.
Restoring Archived Items
In the left pane, near the bottom of the screen, click the Folder List icon.
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· To expand the Archive folder, in the left pane, double-click Archives.

· In the left pane, select the archive folder you want to view. 

Note: If you want to restore archived items to the Exchange server:

· Right-click the item you want to restore. 

· From the drop-down list, select Move.

· Select Other Folder....

· Select the folder to which you want to restore the item.

· Click OK.

Formative Assessment

· Open the mails that you received from your fellow students

· Open the attachments without saving them to disk

· Forward one of the e-mails to your facilitator

· Reply to one of the e-mails you received

· Delete one of the mails

CHANGE THE VIEW, PRINT, MULTIPLE E-MAILS, HELP
Outcomes 
· Print an E-mail message

· Adjust settings to customise the view and preferences of the presentation application
· Work with multiple E-mail messages
Assessment criteria
· Print an E-mail to the default printer:  A whole E-mail, specific text within an E-mail message

· Switch Toolbar menus off and on 

· Change the current view headings 

· Add or delete additional columns from the current view

· Open a number of E-mail messages are opened:  minimum 3 E-mail messages

· Switch control between the open E-mail messages

· Manipulate text between active E-mail messages:  minimum of 2 active E-mail messages; type of manipulation: move, copy

· Copy text to an E-mail message from another source: Any source other than an E-mail source

· Delete text from an E-mail message

Sorting Messages

By default, your mail will display in the Information Viewer in the order of dates they were received.  Outlook allows you to sort your mail in more ways than just the dates: you can also sort by subject, attachments, From (the senders of the mail), To (the receivers of mail), flags, and so on.

· Select the View ribbon, and click on the drop down arrow next to Arrange By in the Arrangement group.  Select the option you require and Outlook will sort your mails accordingly.

· Or, in the Inbox, in the centre pane at the top, click on the arrange by date and a menu with the different options will appear.
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Print An E-Mail

· Open the e-mail

· Select the File, Print menu.

· The Print dialogue box will appear.  Make your selections and click Print
You can print individual items, such as e-mail messages, contacts, or calendar items, or larger views, such as calendars, address books, or content lists of Mail folders.

The procedure for printing is the same in Mail, Calendar, or any other folders in Microsoft Outlook 2010 —  all printing settings and functions are found in the Backstage view. A print preview view is automatically provided to help you choose the settings and options that you want.

1. Click an item or folder in Outlook that you want to print.

2. Click and open the File ribbon
3. On the Print tab, do one of the following:

· Under Print Settings, click Print.

· Select the styles and options that you want. 

· Under Print What, click the style that you want. A preview is shown in the Preview Pane, unless you are printing multiple items. In this case, you are prompted to click Preview in the Preview Pane.

· To change the font, heading or other settings of the style that you want, click Define Print Styles.

If you are satisfied with the appearance that you see in the preview, under Print Settings, you can click Print.

· If you want to specify individual pages or sets of pages to be printed, click Print Options. Enter the options that you want and click Print.

Note:    Clicking Print sends the document to the printer, so be sure you have made all the changes that you want to make before you click Print.

To return to the previous view, click the File tab.
 SHAPE  \* MERGEFORMAT 



Switch Control Between A Number Of E-Mails

You can have more than one e-mail open at the same time and then switch between them at will.

· To open a couple of e-mails, follow the same procedure as when you open one e-mail: 

· Double-click on the e-mail and the mail will open in a separate window that you can see on your taskbar.  

· Double-click on the next e-mail, it will open in a separate window and show on your taskbar.  

· You do this for each e-mail you want to open.
· To switch from one e-mail to another e-mail, simply click on the e-mail’s button on the Taskbar.

· When you do not want to view the e-mail anymore, you don’t have to close it, simply click on the minimise button in the Title Bar and the e-mail will go to the Taskbar.  

· When you need it again, click on the button on the Taskbar.

Manipulate Text Between E-Mails

MS Office enables you to copy and move text between e-mails.  When you copy or cut text, it is placed in the Office Clipboard.  You can place up to 12 items on the Office Clipboard and then paste them one by one in new locations, either in the same e-mail or in different e-mails.  

· Once you have copied text or graphics to the Office Clipboard, do the following:

· If the Office Clipboard is not displaying in your window, go to the Message Ribbon, Clipboard group.  Click the down pointing Office Clipboard and it will show in your window.
· Click in the other e-mail in the place where you want to paste the text or item, and click on the item you want to paste.  The text or item will appear in the new place.
· The text or items will remain on the Office Clipboard until you either delete it from the Clipboard or until you close the application.
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Copy Text From Another Source

The Office Clipboard allows you to copy and move text, graphics and other objects between Office applications.

· To copy or move from another application such as Word or Excel, open the application that contains the text you want to copy or move.  Select the text and copy or cut the text.  It will be pasted to the Office Clipboard.  Go to the place in the e-mail where you want to paste the text and follow the steps above.
Using Help

Use the Office Assistant to Get Help

When you are in the middle of a task and need help, click the Microsoft Outlook Help button to get the help you need. 

Help is hidden by default. You can display it in one of several ways.

Display Help
· On the Ribbon bar, click Microsoft Outlook Help 
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OR

· Press F1
· Help tries to guess what help you might need. If the list of "guessed" Help topics does not include the one you want, type a question, such as "How do I save a document" into the text box then click Search . Click a topic

· Help about the topic you have chosen is displayed beneath the subtopic. 
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Tip
Some help topics contain links to other topics. If you point to any text in blue the mouse pointer changes to a hand [image: image40.png]


.  Click the blue text to jump to the topic. Close the Help window by clicking the Close button [image: image41.png]



Formative Assessment

· Open any three e-mails received from your fellow students

· Copy text from one e-mail to another

· Copy the text from any MS Word document to the third e-mail




Example of creating a signature using a picture





Clipboard
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account.

@ Seemore sbout Pamel Huygen'.
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